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[bookmark: _Toc87279980][bookmark: _Toc90197444][bookmark: _Toc111889202]Introduction

Ce document recueille des informations sur certains de nos ancêtres. Il est forcément incomplet. Bien sûr, il y avait beaucoup plus dans la vie de ces personnes que ce qui est capturé ici. Véritables personnages de chair et de sang, ils ont parcouru la terre, élevé leurs familles, chanté, joué à des jeux, raconté des blagues et vécu pleinement. Ils ont construit leurs familles, leurs fermes et leurs vies et, comme nous tous, ont vécu d'innombrables jours et nuits de chagrin et de joie. Les informations trouvées ici sont un enregistrement de quelques-uns de leurs pas, quelques-unes des marques qu'ils ont laissées, à partir desquelles nous pouvons dire qu'ils étaient ici.

Ils ont tous contribué à créer le monde qui est le nôtre aujourd'hui. Le plus grand honneur que nous puissions leur faire est simplement de faire de notre mieux, avec ce que nous avons et le monde tel que nous le trouvons, pour transmettre à ceux qui viennent ensuite le meilleur avenir possible que nous puissions leur laisser à notre tour.
***
Les informations sont aussi précises que possible au moment de la préparation de ce document. Au fil du temps, des informations supplémentaires et plus précises peuvent être ajoutées par d'autres aux documents trouvés en ligne. Certaines inexactitudes seront toujours présentes, par exemple en ce qui concerne les dates de naissance, simplement à cause de la faillibilité humaine. Cela peut être vu, par exemple, en comparant les dates de naissance données pour les individus dans le Recensement du Canada de 1901 et le Recensement du Canada de 1911, où souvent l'année de naissance diffère d'un an ou deux, et parfois même le mois de naissance change. L'orthographe des noms varie également souvent, car ils ont souvent été enregistrés par un preneur d'enregistrement au mieux qu'ils l'ont entendu d'un locuteur qui n'était peut-être pas capable d'écrire. Dans la mesure du possible, j'ai enregistré ces détails du mieux que j'ai pu à partir des sources disponibles et de l'exemple le plus probablement correct. J'ai essayé d'adopter l'approche la plus conservatrice, et je n'ai ajouté aucune information dont je n'étais pas aussi sûr que possible était exacte.

Les cartes ne montrent qu'une partie de leurs voyages, parfois seulement jusqu'au niveau du comté tel qu'enregistré par les recensements. Les sections chronologiques ne sont que partiellement complètes, répertoriant les informations disponibles sur FamilySearch.org au moment de sa création, par exemple dans de nombreux cas, ils n'incluaient  pas la naissance d'enfants qui n'ont pas encore été saisis dans la base de données FamilySearch. De même, les tableaux en éventail dans les sous-sections Ancêtres, répertoriant les ancêtres sur six générations, affichent autant d'informations que celles disponibles dans FamilySearch au moment de l'impression des tableaux.

Dans la copie électronique, tous les liens en bleu sont cliquables pour vous amener à une autre section pertinente de ce document ou à une page Web contenant plus d'informations.

Vous pouvez zoomer sur des images difficiles à lire en utilisant la fonction de zoom de votre application, qui sur de nombreux ordinateurs peut être effectuée simplement en maintenant la touche Ctrl enfoncée et en utilisant la molette de défilement de la souris. La résolution des images est légèrement plus élevée dans les documents Word que dans les PDF.

La dernière section Using This Document fournit des informations sur l'utilisation, la modification et l'impression de ce document.

Vous pouvez obtenir une copie électronique de ce document que vous pouvez mettre à jour et modifier vous-même à partir de https://williamstewart.com/ancestry/

Ayer du plaisir en lisant ce document,
William Mott Stewart
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[bookmark: _Toc87279986][bookmark: _Toc90197445][bookmark: _Toc111889203]Les Ancêtres April

Cette section comprend l'ascendance de la lignée April, de Marie Rhéa April (1934) incluant trois générations, quinze personnes en tout.


	

	Marie Rhéa April
(1934)
|
Aimé Désiré April
(1909-1985)
Irène Charron
(1912-1989)
____________________|_____________________

	|
François Xavier (Frank) April
(1883-Décédé)
Alice Lepage
(1886-1964)
___________|__________
	|
Joseph Napoléon (Léonce) Charron
(1886-1977)
Marie Alma Thibault
(1889-1989)
___________|__________

	|
François Alexis April
(1845-1915)

(1848-1886)

	|
Joseph Abel Lepage
(1848-1888)
Euphémie Dionne
(1851-1939)

	|
Auguste Charron
(1859-1928)
Aurore Claire Aubut
(1854-1921)
	|
Etienne Thibeault
(1860-1929)
Elise Lemieux
(1863-1895)




[image: ]

[bookmark: _April,_Aimé_Désiré][bookmark: _Toc87279987][bookmark: _Toc111889204]April, Aimé Désiré (1909-1985)

 (
Aimé Désiré April
) (
Marie Rhéa April
) (
Irène Charron
)[image: ]
[bookmark: _Toc111889343]1 - Marie Rhéa April, Aimé Désiré April, Irène Charron

[image: ]
[bookmark: _Toc111889344]2 - Irène Charron, Aimé Désiré April

Fils de François Xavier (Frank) April (1883-Décédé) et Alice Lepage (1886-1964).

Epoux de Irène Charron (1912-1989).

Père de Marie Rhéa April (1934).

Né le 10 août 1909 à Saint-Hubert, Saint-Hubert-de-Rivière-du-Loup, Rivière-du-Loup, Québec, Canada.

Décédé le 26 juin 1985 à Edmundston, Madawaska, New Brunswick, Canada.

[image: ]

Son père était agriculteur, bûcheron et menuisier. En 1921, il vit avec ses parents et son frère aîné, à Grimmer, Restigouche et Madawaska, Nouveau-Brunswick. Sa religion est catholique romaine. Il s'est marié en 1930, à l'âge de 20 ans.  Il a marié Irène Charron et ils ont eu quatre enfants.  Ils ont déménagé à Montréal en 1950. pour le travail de menuisier en rénovation. Il a habité avec Irène au Lac Laniel à Saint-Colomban dans les Laurentides au Québec.  Ils sont revenus habiter avec leur fille Rhéa et sa famille à Edmundston Nouveau-Brunswick en 1984.  Il a vécu jusqu’à l’âge de 75 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/G8BF-8ZS

	https://www.wikitree.com/wiki/April-82




[bookmark: _Toc111889205]Chronologie

https://www.familysearch.org/tree/person/timeline/G8BF-8ZS

[image: ]





[bookmark: _Toc111889206]Baptême (1909)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18440271

[image: ]



[bookmark: _Toc111889207]Recensement du Canada (1921)

Voir François Xavier (Frank) April (1883-1963).



[bookmark: _Marriage_(1930)][bookmark: _Toc111889208]Mariage (1930)

Avec son épouse Irène Charron (1912-1989).

https://familysearch.org/ark:/61903/1:1:QVBN-3W88
[image: ]

[bookmark: _Toc111889209]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _April,_François_Alexis][bookmark: _Toc87279988][bookmark: _Toc111889210]April, François Alexis (1845-1915)

Fils de George April (1805-1893) et Marie-Sarassine Plourde (1813-Décédée), pas encore inclus dans ce document de généalogie.

Epoux de  (1848-1886).

Père de François Xavier (Frank) April (1883-1963).

Né le 15 juillet 1845 à Saint-Georges-de-Cacouna, Rivière-du-Loup, Québec, Canada.

Décédé le 3 avril 1915 à Saint-Hubert, Saint-Hubert-de-Rivière-du-Loup, Rivière-du-Loup, Québec, Canada.

 (
Saint-Hubert
)[image: ]

En 1861, il vit avec sa mère et ses sept frères et sœurs, au Témiscouata, au Québec. Sa mère est agricultrice. Sa religion est catholique romaine. Il se marie en 1866, à l'âge de 21 ans. En 1871, il vit avec ses parents, trois frères et sœurs, sa femme et trois de leurs enfants, à St Antonin, Témiscouata, Québec. Son métier est pêcheur. En 1881, il vit avec sa femme et ses neuf enfants. Son métier est maintenant agriculteur. En 1891, il vit avec son fils et ses quatre petits-enfants, à St Hubert, Témiscouata, Québec. En 1911, il vit avec son fils, sa seconde épouse et neuf membres de sa famille. Il a vécu jusqu'à 69 ans.



Sites de généalogie:

	https://www.familysearch.org/tree/person/details/LKSC-7VP

	https://www.wikitree.com/wiki/April-84





[bookmark: _Toc111889211]Chronologie

https://www.familysearch.org/tree/person/timeline/LKSC-7VP

[image: ]


[image: ]



[image: ]

[bookmark: _Toc111889212]Recensement du Canada (1861)

Avec sa mère Marie-Sarassine Plourde (1813-Décédée).
https://www.ancestry.ca/imageviewer/collections/1570/images/4108842_00287

[image: ]

[bookmark: _Marriage_(1866)_1][bookmark: _Toc111889213]Mariage (1866)

Avec son épouse  (1848-1886).

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18020567

[image: ]

[bookmark: _Canada_Census_(1871)_8][bookmark: _Toc111889214]Recensement du Canada (1871)

Dans la maison de père George April (1805-1893) et mère Marie-Sarassine Plourde (1813-Décédée), avec son épouse  (1848-1886).

https://www.ancestry.ca/imageviewer/collections/1578/images/4395567_00245

[image: ]


[bookmark: _Canada_Census_(1881)_7][bookmark: _Toc111889215]Recensement du Canada (1881)

Avec son épouse  (1848-1886).

https://familysearch.org/ark:/61903/1:1:MVND-DDY (impossible de télécharger, donc capture d'écran)

[image: ]


[bookmark: _Canada_Census_(1891)_3][bookmark: _Toc111889216]Recensement du Canada (1891)

Avec son fils François Xavier (Frank) April (1883-1963). 

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148225-00205

[image: ]


[bookmark: _Toc111889217]Recensement du Canada (1911)

Avec son deuxième épouse Obeline Tremblay (1862-1940).
https://www.ancestry.ca/imageviewer/collections/8947/images/e084_e002089328

[image: ]

[bookmark: _Grave_(1915)][bookmark: _Toc111889218]Tombe (1915)

Avec son épouse  (1848-1886).

https://www.familysearch.org/tree/person/memories/LKSC-7VP

[image: ]

[bookmark: _Toc111889219]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _April,_Francois_Xavier][bookmark: _Toc87279989][bookmark: _Toc111889220]April, François Xavier (Frank) (1883-1963)

[image: ]
[bookmark: _Toc111889345]3 - François Xavier (Frank) April, Alice Lepage

Fils de François Alexis April (1845-1915) et  (1848-1886).

Epoux de Alice Lepage (1886-1964).

Père de Aimé Désiré April (1909-1985).

Né le 20 janvier 1883 à Saint-Antonin, Rivière-du-Loup, Québec, Canada.
[bookmark: _Hlk88895262]
Décédé le 30 mars 1963 à Saint-Antonin, Rivière-du-Loup, Québec, Canada.

 (
Saint-Hubert
)[image: ]

Il est baptisé en 1883, en tant que catholique romain. En 1891, il vit avec ses parents et ses trois frères, à St Hubert, Témiscouata, Québec. Son père est agriculteur. Il se marie en 1905, à l'âge de 22 ans. En 1911, il vit avec sa femme et ses deux enfants, il est agriculteur. En 1921, il vit avec sa femme et ses deux fils, à Grimmer, Restigouche et Madawaska, Nouveau-Brunswick. En 1963, il est cuisinier dans un camp pour bûcherons.  Il a vécu jusqu'à 80 ans.  

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/G9MQ-NY2

	https://www.wikitree.com/wiki/April-83




[bookmark: _Toc111889221]Chronologie

https://www.familysearch.org/tree/person/timeline/G9MQ-NY2

[image: ]


[bookmark: _Toc111889222]Baptême (1883)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18330647

[image: ]

[bookmark: _Toc111889223]Recensement du Canada (1891)

Voir François Alexis April (1845-1915).




[bookmark: _Marriage_(1905)][bookmark: _Toc111889224]Mariage (1905)

Avec son épouse Alice Lepage (1886-1964).

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18440204

[image: ]

[bookmark: _Canada_Census_(1911)_10][bookmark: _Toc111889225]Recensement du Canada (1911)

Avec son épouse Alice Lepage (1886-1964), pour une raison quelconque n'enregistre pas son fils Aimé Désiré April (1909-1985).

https://familysearch.org/ark:/61903/1:1:QVBZ-GTVN
[image: ]
[image: ]


[bookmark: _Canada_Census_(1921)_6][bookmark: _Toc111889226]Recensement du Canada (1921)

Avec son épouse Alice Lepage (1886-1964) et son fils Aimé Désiré April (1909-1985).

https://www.ancestry.ca/discoveryui-content/view/8219662:8991

[image: ]

[bookmark: _Toc111889227]Certificat De Décès (1963)

https://www.ancestry.ca/mediaui-viewer/tree/107971100/person/300062350683/media/ed8a8fae-868c-49f6-abc4-d4000a82fdbb

[image: ]



[bookmark: _Toc111889228]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _April,_Marie_Rhea][bookmark: _April,_Marie_Rhéa][bookmark: _Toc87279990][bookmark: _Hlk87279000][bookmark: _Toc111889229]April, Marie Rhéa (1934)

[image: ]
[bookmark: _Toc111889346]4 - Marie Rhéa April

Fille de Aimé Désiré April (1909-1985) et Irène Charron (1912-1989).

Epouse de Joseph Zénon Daigle (1934).

Mère de Marie Rachel Christine Daigle (1962), Joseph Alain François Daigle (1964), Marie Nathalie Céline Daigle (1966), et Martin Jacques Daigle (1969).

Né le 10 octobre 1934 à Saint-Martin-de-Restigouche, Saint-Quentin, Restigouche, New Brunswick, Canada.

[image: ]

Son père était agriculteur. Elle a grandi avec ses parents, ses frères et sa sœur à Saint-Martin au Nouveau-Brunswick.  Elle a étudié à Edmunston N.B. jusqu’à le départ de la famille pour Montréal en 1950. Elle a étudié en commerce dans un collège de  Montréal pour ensuite travailler dans le domaine de la comptabilité dans une compagnie juive de Montréal.  Elle s’est mariée en 1960 à Montréal à Joseph Zénon Daigle.  Elle a déménagé au Nouveau-Brunswick en 1960.  Elle a eu quatre enfants. Elle obtenu son diplôme universitaire en enseignement de commerce en 1978.  Elle a été la personne qui a su être le soutien de son mari durant sa carrière en politique.  Elle a participé bénévolement dans plusieurs organismes communautaires.  Elle travaillait comme directrice d’un atelier de personnes avec déficiences intellectuelles.  Elle a enseigné au Collège Communautaire d’Edmundston. Elle est une athlète dans plusieurs sports dont le ski alpin et le tennis depuis son jeune âge.  Elle vit avec son mari Joseph à Moncton Nouveau-Brunswick et au chalet à Richibuctou durant les saisons estivales.



Sites de généalogie (notez que les personnes vivantes ne sont pas visibles tant que vous n’avez pas de compte sur le site et n’avez pas reçu l’autorisation d’accéder à la page par le créateur, dans ce cas William Mott Stewart, ou recréez la page sous votre propre compte):

	https://www.familysearch.org/tree/person/details/G8D8-LLG

	https://www.wikitree.com/wiki/April-80





[bookmark: _Toc111889230]Chronologie

https://www.familysearch.org/tree/person/timeline/G8D8-LLG

[image: ]


[bookmark: _Toc111889231]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Aubut,_Aurore_Claire][bookmark: _Toc87279991][bookmark: _Toc111889232]Aubut, Aurore Claire (1854-1921)

[image: ]
[bookmark: _Toc111889347]5 - Aurore Claire Aubut

[image: ]
[bookmark: _Toc111889348]6 - Maison de Aurore Claire Aubut
https://www.ancestry.ca/mediaui-viewer/tree/116258229/person/330154652858/media/8e182c2d-6aa7-488f-992c-9f92ae1876fa

Fille de Élie Théodore Aubut (1822-1890) et Sara Tremblay (1830-1921), pas encore inclus dans ce document de généalogie.

Epouse de Auguste Charron (1859-1928).

Mère de Joseph Napoléon (Léonce) Charron (1886-1977).

Né le 20 décembre 1854 à Saint-Éloi, Les Basques, Québec, Canada.

Décédée le 27 avril 1921 à Saint-Clément, Les Basques, Québec, Canada.

 (
Saint-Clément
)[image: ]


En 1861, elle vit avec ses parents, sa grand-mère paternelle et ses six frères et sœurs, à Saint-Éloi, Témiscouata, Québec. Son père est agriculteur. Elle se marie en 1880, à l'âge de 25 ans. En 1881, elle vit avec son mari, son fils et les parents et frères et sœurs de son mari, à St Clément, Témiscouata, Québec. Son mari est agriculteur. En 1891, elle vit avec son mari et ses sept enfants. En 1901, elle vit avec son mari et ses dix enfants. En 1910, elle vit avec son mari et ses cinq enfants, à Salem, Essex, Massachusetts. Son mari est maintenant menuisier et construit des maisons. En 1911, elle vit avec son mari et ses cinq enfants, maintenant de retour à St Clément, Témiscouata, Québec. Son mari est agriculteur. En 1912, elle a traversé la frontière américaine avec son mari, ses quatre enfants, son fils et sa famille, en route pour Salem, Massachusetts. Son mari est à nouveau menuisier. Elle a vécu jusqu'à 86 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/K23C-1G5

	https://www.wikitree.com/wiki/Aubut-99





[bookmark: _Toc111889233]Chronologie

https://www.familysearch.org/tree/person/timeline/K23C-1G5

[image: ]


[image: ]



[image: ]


[bookmark: _Toc111889234]Recensement du Canada (1861)
Dans la maision du père Élie Théodore Aubut (1822-1890) et mère Sara Tremblay (1830-1921), avec grand-mère Marie Félicité Morais (1785-1869).
https://www.ancestry.ca/imageviewer/collections/1570/images/4108842_00416
[image: ]

[bookmark: _Toc111889235]Mariage (1880)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889236]Recensement du Canada (1881)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889237]Recensement du Canada (1891)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889238]Recensement du Canada (1901)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889239]Recensement des États-Unis (1910)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889240]Recensement du Canada (1911)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889241]Passage De La Frontière Américaine (1912)

Voir Auguste Charron (1859-1928).




[bookmark: _Toc111889242]Nécrologie (1921)

https://www.ancestry.ca/mediaui-viewer/tree/178335720/person/182320213424/media/bbb3b746-8ed1-4bb3-b2db-829952892911

[image: ]


[bookmark: _Toc111889243]Tombe (1921)

https://www.findagrave.com/memorial/165318882/claire-aurore-charron

Claire Aurore Aubut Charron
Birth 	20 Dec 1854
Canada

Death 	7 Apr 1921 (aged 66)
Canada

Burial 	
Saint Clement Cemetery
Les Basques, Bas-Saint-Laurent Region, Québec, Canada

Memorial ID 	165318882



[bookmark: _Toc111889244]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Charron,_Auguste_(1859–1928)][bookmark: _Toc87279992][bookmark: _Toc111889245]Charron, Auguste (1859-1928)

[image: ]

[bookmark: _Toc111889349]7 - Auguste Charron, Joseph Napoléon (Léonce) Charron (1886-1977), Aurore Claire Aubut (1854-1921)

Fils de Marcellin Ferrière dit Charon (1818-1895) et Constance Côté (1814-1894), pas encore inclus dans ce document de généalogie.

Epoux de Aurore Claire Aubut (1854-1921).

Père de Joseph Napoléon (Léonce) Charron (1886-1977).

Né le 16 août 1859 à Saint-Jean-Baptiste-de-L'Isle-Verte, Québec, Canada.

Décédé le 22 novembre 1928 à Salem, Essex, Massachusetts, États-Unis d'Amérique.



 (
Saint-Cyprien
) (
Saint-Clément
)[image: ]



En 1871, il vit avec ses parents et trois frères et sœurs aînés, à St Cyprien de Hocquart, Témiscouata, Québec. Son père est agriculteur. Sa religion est catholique romaine. Il se marie en 1880, à l'âge de 20 ans. En 1881, il habite une maison avec ses parents, son frère et sa famille, sa femme et son fils, à St Clément, Témiscouata, Québec. Il est un fermier. En 1891, il vit avec sa femme et ses sept enfants. En 1901, il vit avec sa femme et ses dix enfants. En 1910, il vit avec sa femme et ses cinq enfants, à Salem, Essex, Massachusetts. Il est maintenant menuisier et construit des maisons. En 1911, il vit avec sa femme et ses cinq enfants, maintenant de retour à St Clément, Témiscouata, Québec. Il est un fermier. En 1912, il a traversé la frontière américaine avec sa femme, ses quatre enfants, son fils et sa famille, en route pour Salem, Massachusetts. Il est à nouveau menuisier. Il a vécu jusqu'à 69 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/K23C-15Q

	https://www.wikitree.com/wiki/Charron-965


[bookmark: _Toc111889246]Chronologie

https://www.familysearch.org/tree/person/timeline/K23C-15Q

[image: ]



[image: ]



[image: ]


[bookmark: _Toc111889247]Recensement du Canada (1871)

Dans la maison du père Marcellin Ferrière dit Charon (1818-1895) et mère Constance Côté (1814-1894).
https://www.ancestry.ca/imageviewer/collections/1578/images/4395567_00551
[image: ]

[bookmark: _Mariage_(1880)][bookmark: _Toc111889248]Mariage (1880)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18360353 et https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18360354

[image: ]



[image: ]






[bookmark: _Canada_Census_(1881)_8][bookmark: _Toc111889249]Recensement du Canada (1881)

Dans la maison à côté de la maison du père Marcellin Ferrière dit Charon (1818-1895) et mère Constance Côté (1814-1894), avec son épouse Aurore Claire Aubut (1854-1921). 
https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13190-00203
[image: ]


[bookmark: _Canada_Census_(1891)_7][bookmark: _Toc111889250]Recensement du Canada (1891)
Avec son épouse Aurore Claire Aubut (1854-1921) et fils Joseph Napoléon (Léonce) Charron (1886-1977).
https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148225-00119
[image: ]


[bookmark: _Canada_Census_(1901)_13][bookmark: _Toc111889251]Recensement du Canada (1901)
Avec son épouse Aurore Claire Aubut (1854-1921) et fils Joseph Napoléon (Léonce) Charron (1886-1977).
https://www.ancestry.ca/imageviewer/collections/8826/images/z000173504
[image: ]

[image: ]



[bookmark: _US_Census_(1910)][bookmark: _Toc111889252]Recensement des États-Unis (1910)

Avec son épouse Aurore Claire Aubut (1854-1921).

https://www.ancestry.ca/imageviewer/collections/7884/images/31111_4330069-00161

[image: ]


[bookmark: _Canada_Census_(1911)_9][bookmark: _Toc111889253]Recensement du Canada (1911)

Avec son épouse Aurore Claire Aubut (1854-1921).

https://familysearch.org/ark:/61903/1:1:QVBZ-GWC6 ou https://familysearch.org/ark:/61903/1:1:QVBZ-GWCX

[image: ]

[image: ]



[bookmark: _Passage_De_La][bookmark: _Toc111889254]Passage De La Frontière Américaine (1912)

Avec son épouse Aurore Claire Aubut (1854-1921) et fils Joseph Napoléon (Léonce) Charron (1886-1977) avec son épouse Marie Alma Thibault (1889-1989).

https://www.ancestry.ca/imageviewer/collections/1075/images/m1464_179-0104
[image: ]

[image: ]

[bookmark: _Toc111889255]Enregistrement De Décès (1928)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18361318

[image: ]


[bookmark: _Toc111889256]Tombe (1928)

https://www.findagrave.com/memorial/165318864/auguste-charron

Auguste Charron

Birth 	16 Aug 1859
Québec, Canada

Death 	22 Nov 1928 (aged 69)

Burial 	
Saint Clement Cemetery
Les Basques, Bas-Saint-Laurent Region, Québec, Canada

Memorial ID 	165318864 · View Source



[bookmark: _Toc111889257]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Charron,_Irène_(1912-1989)][bookmark: _Toc87279993][bookmark: _Toc111889258]Charron, Irène (1912-1989)

[image: ]
[bookmark: _Toc111889350]8 - Irène Charron
Famille de Joseph Napoléon (Léonce) Charron

Fille de Joseph Napoléon (Léonce) Charron (1886-1977) et Marie Alma Thibault (1889-1989).

Epouse de Aimé Désiré April (1909-1985).

Mère de Marie Rhéa April (1934).

Né le 22 juillet 1912 à Salem, Essex, Massachusetts, United States.

Décédée le 11 août 1989 à Edmundston, Madawaska, New Brunswick, Canada.



 (
Saint-Martin
)[image: ]

En 1921, elle vit avec ses parents et sept frères et sœurs, à Grimmer, Restigouche et Madawaska, Nouveau-Brunswick. Sa religion est catholique romaine. Son père est menuisier. Elle se marie en 1930, à 21 ans. Elle a eu quatre enfants.  Elle et son mari sont déménagés à Montréal pour l’emploi de son mari en 1950 accompagné de trois de leurs enfants. Elle a participé dans les chorales accompagnée de ses sœurs.  Elle et son mari Aimé ont ensuite habité au Lac Laniel à Saint-Colomban dans les Laurentides pour ensuite retourner vivre chez leur fille Rhéa à Edmundston Nouveau-Brunswick en 1984, Elle est allé vivre avec ses sœurs à la maison familiale à Saint-Martin en 1986.  Elle a vécu jusqu'à 77 ans.



Sites de généalogie:

	https://www.familysearch.org/tree/person/details/G8BF-4S1

	https://www.wikitree.com/wiki/Charron-963


[bookmark: _Toc111889259]Chronologie

https://www.familysearch.org/tree/person/timeline/G8BF-4S1

[image: ]



[bookmark: _Toc111889260]Enregistrement De Naissance (1912)

https://familysearch.org/ark:/61903/1:1:FXVW-2LF

[image: ]

[image: ]

[bookmark: _Toc111889261]Recensement du Canada (1921)

Voir Joseph Napoléon (Léonce) Charron (1886-1977).

[bookmark: _Toc111889262]Mariage (1930)

Voir Aimé Désiré April (1909-1985).



[bookmark: _Toc111889263]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Charron,_Joseph_Napoleon][bookmark: _Toc87279994][bookmark: _Toc111889264]Charron, Joseph Napoléon (Léonce) (1886-1977)

[image: ]
9 - Joseph Napoléon (Léonce) Charron

[image: ]
[bookmark: _Toc111889352]10 - Famille de Joseph Napoléon (Léonce) Charron
Famille de Joseph Napoléon (Léonce) Charron


Fils de Auguste Charron (1859-1928) et Aurore Claire Aubut (1854-1921).

Epoux de Marie Alma Thibault (1889-1989).

Père de Irène Charron (1912-1989).

Né le 26 octobre 1886 à St-Clement, Riviere-du-Loup, Québec, Canada.

Décédé le c. 1977 à Saint-Martin-de-Restigouche, Saint-Quentin, Restigouche, New Brunswick, Canada.

[image: ]

Il est baptisé en 1886, en tant que catholique romain. En 1891, il vit avec ses parents , six frères et sœurs, à St-Clément, Témiscouata, Québec. Son père est agriculteur. En 1901, il vit avec ses parents et neuf frères et sœurs. Il se marie en 1908, à l'âge de 21 ans. En 1912, il traverse la frontière américaine avec sa femme, ses deux enfants, ses parents et ses frères et sœurs, en route pour Salem, Massachusetts. Il est menuisier. En 1921, il vit avec sa femme et ses huit enfants, à Grimmer, Restigouche et Madawaska, Nouveau-Brunswick. Dans les Listes électorales du Canada de 1968, il est rentier. Il a participer à la construction de plusieurs églises au Nouveau-Brunswick . Il a vécu jusqu'à 90 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/K8SD-PPP

	https://www.wikitree.com/wiki/Charron-964




[bookmark: _Toc111889265]Chronologie

https://www.familysearch.org/tree/person/timeline/K8SD-PPP

[image: ]



[image: ]



[bookmark: _Toc111889266]Baptême (1886)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18360491

[image: ]

[bookmark: _Toc111889267]Recensement du Canada (1891)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889268]Recensement du Canada (1901)

Voir Auguste Charron (1859-1928).




[bookmark: _Marriage_(1908)][bookmark: _Toc111889269]Mariage (1908)

Avec son épouse Marie Alma Thibault (1889-1989).

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18360890
[image: ]
[image: ]



[bookmark: _Toc111889270]Passage De La Frontière Américaine (1912)

Voir Auguste Charron (1859-1928).




[bookmark: _Canada_Census_(1921)_7][bookmark: _Toc111889271]Recensement du Canada (1921)

Avec son épouse Marie Alma Thibault (1889-1989) et fille Irène Charron (1912-1989).
https://www.ancestry.ca/imageviewer/collections/8991/images/1921_034-E002896506
[image: ]

[bookmark: _Canada_Voter_Lists_1][bookmark: _Toc111889272]Listes Electorales Du Canada (1968)

Avec son épouse Marie Alma Thibault (1889-1989)
https://www.ancestry.ca/imageviewer/collections/2983/images/33022_302741-01256
[image: ]

[image: ]

[bookmark: _Toc111889273]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Dionne,_Euphemie_(1851–1939)][bookmark: _Toc87279995][bookmark: _Toc111889274]Dionne, Euphémie (1851-1939)

Fille de Germain Dionne (1827-Décédé) et Basilice Saindon (1830-1892), pas encore inclus dans ce document de généalogie.

Epouse de Joseph Abel Lepage (1848-1888).

Mère de Alice Lepage (1886-1964).

Né le 15 février 1851 à Saint-Georges-de-Cacouna, Rivière-du-Loup, Québec, Canada.

Décédée le mars 1939 au Nouveau-Brunswick, Canada.

Elle est baptisée en 1851, en tant que catholique romaine. En 1851, elle vit avec ses parents à St George de Cacouna, comté de Rimouski, Québec. Son père est journalier. Elle se marie en 1874, à l'âge de 23 ans. En 1881, elle vit avec son mari et ses cinq enfants, à St-Epiphane, Témiscouata, Québec. Son mari est agriculteur. Elle a vécu jusqu'à 98 ans.

 (
Saint-Épiphane
)[image: ]

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/L82W-TZ3

	https://www.wikitree.com/wiki/Dionne-1109



[bookmark: _Toc111889275]Chronologie

https://www.familysearch.org/tree/person/timeline/L82W-TZ3

[image: ]



[image: ]



[image: ]


[bookmark: _Toc111889276]Baptême (1851)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18020237

[image: ]



[bookmark: _Toc111889277]Recensement du Canada (1851)

Dans la maison de père Germain Dionne (1827-Décédé) et mère Basilice Saindon (1830-1892).
https://www.ancestry.ca/imageviewer/collections/1061/images/e093-e002312224
[image: ]

[bookmark: _Toc111889278]Mariage (1874)

Voir Joseph Abel Lepage (1848-1888).

[bookmark: _Toc111889279]Recensement du Canada (1881)

Voir Joseph Abel Lepage (1848-1888).




[bookmark: _Toc111889280]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Lemieux,_Elise_(1863–1895)][bookmark: _Toc87279996][bookmark: _Toc111889281]Lemieux, Elise (1863-1895)

Fille de Narcisse Lemieux (1834-1920) et Philomène Caron (1836-1922), pas encore inclus dans ce document de généalogie.

Epouse de Etienne Thibeault (1860-1929).

Mère de Marie Alma Thibault (1889-1989).

Né le 1863 à L'Isle-Verte, Témiscouata, Québec, Canada.

Décédée le 12 février 1895 à Saint-Clément, Témiscouata, Québec, Canada.

 (
Saint-Clément
)[image: ]

En 1871, elle vit avec ses parents et sept frères et sœurs, à l'Île Verte, Témiscouata, Québec. Sa religion est catholique romaine. Son père est agriculteur. En 1881, elle vit avec ses parents, sept frères et sœurs et ses grands-parents. Elle se marie en 1882, à l'âge de 19 ans. En 1891, elle vit avec son mari et ses six enfants, à côté de ses beaux-parents, à St Clément, Témiscouata, Québec. Son mari est agriculteur. Elle a vécu jusqu'à 31 ans.



Sites de généalogie:

	https://www.familysearch.org/tree/person/details/G7WD-Z2Z

	https://www.wikitree.com/wiki/Lemieux-1436




[bookmark: _Toc111889282]Chronologie

https://www.familysearch.org/tree/person/timeline/G7WD-Z2Z

[image: ]

[bookmark: _Toc111889283]Recensement du Canada (1871)

Avec le père Narcisse Lemieux (1834-1920) et mère Philomène Caron (1836-1922).
https://www.ancestry.com/imageviewer/collections/1578/images/4395458_00455

[image: ]

[image: ]

[image: ]

[bookmark: _Toc111889284]Mariage (1882)

Voir Etienne Thibeault (1860-1929).



[bookmark: _Toc111889285]Recensement du Canada (1881)

Avec le père Narcisse Lemieux (1834-1920) et mère Philomène Caron (1836-1922), dans la maison du grand-père Romain Lemieux (1806-1891) et la grand-mère Marie-Nathalie Thalie Côté (1812-1876), pour une raison quelconque, tout le monde est enregistré avec le nom de famille Cote.

https://www.ancestry.com/imageviewer/collections/1577/images/31229_C_13190-00059

[image: ]

[image: ]

[image: ]


[bookmark: _Toc111889286]Recensement du Canada (1891)

Voir Etienne Thibeault (1860-1929).

[bookmark: _Toc111889287]Enregistrement De Décès (1895)

https://www.ancestry.com/imageviewer/collections/1091/images/d13p_18360635

[image: ]

[bookmark: _Toc111889288]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Lepage,_Alice_(1886–1964)][bookmark: _Toc87279997][bookmark: _Toc111889289]Lepage, Alice (1886-1964)

Fille de Joseph Abel Lepage (1848-1888) et Euphémie Dionne (1851-1939).

Epouse de François Xavier (Frank) April (1883-1963).

Mère de Aimé Désiré April (1909-1985).

Né le 24 juillet 1886 à Saint-Épiphane, Rivière-du-Loup, Québec, Canada.

Décédée le juin 1964 à Saint-Martin-de-Restigouche, Saint-Quentin, Restigouche, New Brunswick, Canada.

 (
Saint-Martin
) (
Saint-Hubert
)[image: ]

Son père était agriculteur. Elle se marie en 1905, à l'âge de 20 ans. En 1911, elle vit avec son mari et ses deux enfants, à St Hubert, Témiscouata, Québec. Sa religion est catholique romaine. Son mari est agriculteur. En 1921, elle vit avec son mari et ses deux enfants, à Grimmer, Restigouche et Madawaska, Nouveau-Brunswick. Elle est la propriétaire du magasin général de Saint-Martin et une des cuisinière au moulin de la région.  Elle a vécu jusqu'à 77 ans. 

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/G99M-WFQ

	https://www.wikitree.com/wiki/Lepage-842




[bookmark: _Toc111889290]Chronologie

https://www.familysearch.org/tree/person/timeline/G99M-WFQ

[image: ]



[image: ]



[bookmark: _Toc111889291]Mariage (1905)

Voir François Xavier (Frank) April (1883-1963).

[bookmark: _Toc111889292]Recensement du Canada (1911)

Voir François Xavier (Frank) April (1883-1963).

[bookmark: _Toc111889293]Recensement du Canada (1921)

Voir François Xavier (Frank) April (1883-1963).



[bookmark: _Toc111889294]Enregistrement De Décès (1964)

https://www.ancestry.ca/mediaui-viewer/tree/107971100/person/300062359080/media/7cd2072f-f84c-46c3-b454-8048c0e96dfc
[image: ]


[bookmark: _Toc111889295]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
[image: ]


[bookmark: _Lepage,_Joseph_Abel][bookmark: _Toc87279998][bookmark: _Toc111889296]Lepage, Joseph Abel (1848-1888)

Fils de Sifroy Lepage (1823-1895) et Marie Hélène Demeules (1828-1893), pas encore inclus dans ce document de généalogie.

Epoux de Euphémie Dionne (1851-1939).

Père de Alice Lepage (1886-1964).

Né le 16 octobre 1848 à Saint-Germain-de-Rimouski, Rimouski, Québec, Canada.

Décédé le 1888 au Massachusetts, USA.



 (
Saint-Épiphane
)[image: ]



Il est baptisé en 1848, en tant que catholique romain. En 1851, il vit avec ses parents et sa sœur cadette, à St Arsène, comté de Rimouski, Québec. Son père est menuisier. En 1861, il vit avec ses parents et ses cinq frères et sœurs. Son père est maintenant agriculteur. En 1871, il vit avec ses parents et sept frères et sœurs, à Viger et Demers, Témiscouata, Québec. Il se marie en 1874, à l'âge de 25 ans. En 1881, il vit avec sa femme et ses cinq enfants, à St Épiphane, Témiscouata, Québec. Il est un fermier. Il a vécu jusqu'à 43 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/96X1-HJ6

	https://www.wikitree.com/wiki/Lepage-843




[bookmark: _Toc111889297]Chronologie

https://www.familysearch.org/tree/person/timeline/96X1-HJ6
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[bookmark: _Toc111889298]Baptême (1848)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_17180960
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[image: ]

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18020062
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[bookmark: _Toc111889299]Recensement du Canada (1851)

Dans la maison du père Sifroy Lepage (1823-1895) et mère Marie Hélène Demeules (1828-1893).

https://www.ancestry.ca/imageviewer/collections/1061/images/e093-e002312290
[image: ]
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[bookmark: _Toc111889300]Recensement du Canada (1861)

Dans la maison du père Sifroy Lepage (1823-1895) et mère Marie Hélène Demeules (1828-1893).

https://www.ancestry.ca/imageviewer/collections/1570/images/4108843_00227
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[bookmark: _Toc111889301]Recensement du Canada (1871)

Dans la maison du père Sifroy Lepage (1823-1895) et mère Marie Hélène Demeules (1828-1893).

https://www.ancestry.ca/imageviewer/collections/1578/images/4395567_00450
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[bookmark: _Marriage_(1874)][bookmark: _Toc111889302]Mariage (1874)

Avec son épouse Euphémie Dionne (1851-1939).

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18590855
[image: ]

[bookmark: _Canada_Census_(1881)_9][bookmark: _Toc111889303]Recensement du Canada (1881)

Avec son épouse Euphémie Dionne (1851-1939).
https://familysearch.org/ark:/61903/1:1:MVND-GHL & https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13190-00116
[image: ]


[bookmark: _Toc111889304]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
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[bookmark: _Pinet,_Marie_Victoire][bookmark: _Toc87279999][bookmark: _Toc111889305]Pinet, Marie Victoire (1848-1886)

Fille de Jean-Baptiste Pinet (1811-1880) et Emilie Grandmaison (1826-Décédée), pas encore inclus dans ce document de généalogie.

Epouse de François Alexis April (1845-1915).

Mère de François Xavier (Frank) April (1883-1963).

Né le 23 octobre 1848 à Saint-Georges-de-Cacouna, Rivière-du-Loup, Québec, Canada.

Décédée le 7 août 1886 à Saint-Hubert, Saint-Hubert-de-Rivière-du-Loup, Rivière-du-Loup, Québec, Canada.

 (
Saint-Hubert
)[image: ]

Elle est baptisée en 1848, en tant que catholique romaine. En 1851, elle vit avec ses parents et ses quatre frères et sœurs, à St George de Cacouna, comté de Rimouski, Québec. Son père est agriculteur. En 1861, elle vit avec ses parents et sept frères et sœurs. En 1866, elle se marie, à l'âge de 17 ans. En 1871, elle vit avec son mari et ses trois enfants, à côté des parents de son mari, à St Antonin, Témiscouata, Québec. Son mari est pêcheur. En 1881, elle vit avec son mari et ses neuf enfants. Son mari est maintenant agriculteur. Elle a vécu jusqu'à 37 ans.



Sites de généalogie:

	https://www.familysearch.org/tree/person/details/KZPV-SLQ

	https://www.wikitree.com/wiki/Pinet-169




[bookmark: _Toc111889306]Chronologie

https://www.familysearch.org/tree/person/timeline/KZPV-SLQ
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[bookmark: _Toc111889307]Baptême (1848)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18020149
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[bookmark: _Toc111889308]Recensement du Canada (1851)

Dans la maison de père Jean-Baptiste Pinet (1811-1880) et mère Emilie Grandmaison (1826-Décédée).

https://www.ancestry.ca/imageviewer/collections/1061/images/e093-e002312200
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[bookmark: _Toc111889309]Recensement du Canada (1861)

Dans la maison du père Jean-Baptiste Pinet (1811-1880) et mère Emilie Grandmaison (1826-Décédée).

https://www.ancestry.ca/imageviewer/collections/1570/images/4108842_00555
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[bookmark: _Toc111889310]Mariage (1866)

Voir François Alexis April (1845-1915).

[bookmark: _Toc111889311]Recensement du Canada (1871)

Voir François Alexis April (1845-1915).

[bookmark: _Toc111889312]Recensement du Canada (1881)

Voir François Alexis April (1845-1915).

[bookmark: _Toc111889313]Enregistrement De Décès (1886)

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_18431440
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[bookmark: _Toc111889314]Tombe (1886)

Voir François Alexis April (1845-1915).


[bookmark: _Toc111889315]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
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[bookmark: _Thibeault,_Etienne_(1860–1929)][bookmark: _Toc87280000][bookmark: _Toc111889316]Thibeault, Etienne (1860-1929)

Fils de Joseph Thibault (1832-1897) et Séraphine Marquis (1832-1913), pas encore inclus dans ce document de généalogie.

Epoux de Elise Lemieux (1863-1895).

Père de Marie Alma Thibault (1889-1989).

Né le 26 janvier 1860 à Saint-Arsène, Rivière-du-Loup, Québec, Canada.

Décédé le 3 février 1929 à Salem, Essex, Massachusetts, United States.



 (
Saint-Paul-de-la-Croix
) (
Saint-Cyprien
)[image: ]

En 1871, il vit avec ses parents et huit frères et sœurs, à St Cyprien de Hocquart, Témiscouata, Québec. Sa religion est catholique romaine. Son père est agriculteur. En 1881, il vit avec ses parents et neuf frères et sœurs, à St Paul de la Croix, Témiscouata, Québec. Il se marie en 1882, à l'âge de 22 ans. En 1891, il vit avec sa femme et ses six enfants, à côté de ses parents. Il est un fermier. En 1910, il vit avec sa femme et ses cinq enfants, à Salem, dans le Massachusetts. C'est un ouvrier travaillant dans un chemin de fer. En 1920, il vit avec sa femme et ses six enfants, toujours à Salem, Massachusetts. Son métier est boulanger. Sa nécrologie indique qu'il laisse derrière lui 40 petits-enfants. Il a vécu jusqu'à 69 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/L13G-35S

	https://www.wikitree.com/wiki/Thibault-961





[bookmark: _Toc111889317]Chronologie

https://www.familysearch.org/tree/person/timeline/L13G-35S
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[bookmark: _Toc111889318]Recensement du Canada (1871)

Dans la maison du père Joseph Thibault (1832-1897) et mère Séraphine Marquis (1832-1913).

https://www.ancestry.ca/imageviewer/collections/1578/images/4395567_00535

[image: ]
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[bookmark: _Toc111889319]Recensement du Canada (1881)

Dans la maison du père Joseph Thibault (1832-1897) et mère Séraphine Marquis (1832-1913).

https://familysearch.org/ark:/61903/1:1:MVND-TZT & https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13190-00182
[image: ]


[bookmark: _Marriage_(1882)][bookmark: _Toc111889320]Mariage (1882)

Avec son épouse Elise Lemieux (1863-1895).

https://www.ancestry.com/imageviewer/collections/1091/images/d13p_18530999

[image: ]

[bookmark: _Canada_Census_(1891)_8][bookmark: _Toc111889321]Recensement du Canada (1891)

Avec son épouse Elise Lemieux (1863-1895) et fille Marie Alma Thibault (1889-1989), à côté de la maison du père Narcisse Lemieux (1834-1920) et mère Philomène Caron (1836-1922) de Elise Lemieux.
https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148225-00120
[image: ]

[bookmark: _Toc111889322]Recensement des États-Unis (1910)

Avec sa deuxième épouse Alphena.

https://www.ancestry.ca/imageviewer/collections/7884/images/31111_4330069-00254
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[bookmark: _Toc111889323]Recensement des États-Unis (1920)

Avec sa deuxième épouse Alphena.

https://www.ancestry.ca/imageviewer/collections/6061/images/4301094_00217
[image: ]

[bookmark: _Toc111889324]Nécrologie (1929)

https://www.ancestry.ca/mediaui-viewer/tree/107971100/person/300062351281/media/e9784e74-35eb-468f-bf33-c67cec791430
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[bookmark: _Toc111889325]Tombe (1929)

Avec sa deuxième épouse Alphena.

https://www.ancestry.ca/mediaui-viewer/tree/107971100/person/300062351281/media/edc5e600-3b53-4491-847a-cddbea3173e7

[image: ]



https://www.findagrave.com/memorial/196218390/etienne-thibault

Etienne Thibault

Birth 	26 Jan 1860
Saint-Arsène, Bas-Saint-Laurent Region, Québec, Canada

Death 	3 Feb 1929 (aged 69)
Salem, Essex County, Massachusetts, USA

Burial 	
Saint Mary's Cemetery
Salem, Essex County, Massachusetts, USA

Memorial ID 	196218390 · View Source



[bookmark: _Toc111889326]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
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[bookmark: _Thibault,_Marie_Alma][bookmark: _Toc87280001][bookmark: _Toc111889327]Thibault, Marie Alma (1889-1989)

[image: ]
[bookmark: _Toc111889353]11 - Marie Alma Thibault
Famille de Joseph Napoléon (Léonce) Charron

Fille de Etienne Thibeault (1860-1929) et Elise Lemieux (1863-1895).

Epouse de Joseph Napoléon (Léonce) Charron (1886-1977).

Mère de Irène Charron (1912-1989).

Né le 26 avril 1889 à St-Clement, Riviere-du-Loup, Québec, Canada.

Décédée le 26 novembre 1989 à Saint-Martin-de-Restigouche, Saint-Quentin, Restigouche, New Brunswick, Canada.

[image: ]

Son père était agriculteur. En 1891, elle vit avec ses parents et ses cinq frères et sœurs, dans une maison à côté des parents de son mari, à St Clément, Témiscouata, Québec. Sa religion est catholique romaine. Son mari est agriculteur. Elle s'est mariée en 1908, à l'âge de 18 ans. En 1912, elle a traversé la frontière américaine avec son mari, ses deux enfants, les parents et la famille de son mari, en route pour Salem, Massachusetts. Son mari est maintenant menuisier. En 1921, elle vit avec son mari et ses huit enfants, à Grimmer, Restigouche et Madawaska, Nouveau-Brunswick. Elle figure sur les Listes électorales du Canada pour 1968. Elle a vécu jusqu'à 100 ans.

Sites de généalogie:

	https://www.familysearch.org/tree/person/details/MT8L-GZB

	https://www.wikitree.com/wiki/Thibault-1564




[bookmark: _Toc111889328]Chronologie

https://www.familysearch.org/tree/person/timeline/MT8L-GZB
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[bookmark: _Toc111889329]Recensement du Canada (1891)

Voir Etienne Thibeault (1860-1929).

[bookmark: _Toc111889330]Mariage (1908)

Voir Joseph Napoléon (Léonce) Charron (1886-1977).

[bookmark: _Toc111889331]Passage De La Frontière Américaine (1912)

Voir Auguste Charron (1859-1928).

[bookmark: _Toc111889332]Recensement du Canada (1921)

Voir Joseph Napoléon (Léonce) Charron (1886-1977).

[bookmark: _Toc111889333]Listes Electorales Du Canada (1968)

Voir Joseph Napoléon (Léonce) Charron (1886-1977).




[bookmark: _Toc111889334]Ancêtres
Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus d’informations.
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[bookmark: _Using_This_Document][bookmark: _Toc87280082][bookmark: _Toc90197446][bookmark: _Toc111889335]Using This Document

The following sections provide information on using, modifying, and printing this document.  You can get a soft-copy that you can update and modify yourself from https://williamstewart.com/ancestry/

Note that you can keep multiple copies of this document open at the same time in Word by selecting View > Window > New Window.  You can then keep your focus in one place in one copy, and jump around in the other copies.

[bookmark: _Toc87280083][bookmark: _Toc111889336]Genealogy Websites & Links

The family tree in this document is primarily maintained in FamilySearch.org, a free site sponsored by the Church of Latter Day Saints.  Much of the information is also available in Wikitree.com, and links to Wikitree have also been included.  All this information is available to anyone with a free account on these sites.

Ancestry.com also provides a free membership option, however only paid accounts can access source documents.  A paid subscription might be worth it if you are doing a lot of research, since Ancestry.com has many source documents not available in FamilySearch.org.  I paid for a six month subscription, worked steadily to create this document, and will not need to renew my subscription.  Fortunately, you do not need a paid account to create a family tree, and if you do subscribe to a paid account your tree will still remain available to you once your paid subscription ends and you revert to a free account.  However, you will lose access to the source documents.  Therefore, any applicable source documents found on Ancestry.com have been copied directly into this document, and a link to the source page included for completeness.  

Note that if you copy source links from Ancestry.com, it must be in a generic form that will be available from any paid Ancestry.com account.  That is, any links to sources on Ancestry.com that include a person ID or tree ID will only be available from your account and not be accessible by others, even if their account is paid.  However, you can often extract a link to the source document that will be accessible to others (with a paid Ancestry subscription) as follows.

Take the hint to the Canada Census 1901 for William Albert Mott as an example.  From your paid Ancestry.com account, let us say you access the hints page and click on that hint.  That takes you to a page that includes an option to view the hint.  If you then click on the document, or click on View, it takes you to a separate page that shows the image for the census page, with a URL that looks something like the following:

https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771?treeid=177738919&personid=192311829107&hintid=&usePUB=true&usePUBJs=true&pId=11479208

Note that this includes a “treeid” and “personid” that will be specific to your paid Ancestry.com account, and not accessible to others.  However, if you click in the web page address bar, and select just the part of the URL before the “?”, you get a generic standalone link to that census page that should be accessible to anyone with a currently paid Ancestry.com account:

https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771

Wherever possible, links to Ancestry.com sources in this document are in this generic format.  

[bookmark: _Toc87280084][bookmark: _Toc111889337]Magnifying and Uncropping Images

Some of the source documents may be difficult to read when printed.  However, in the soft-copy of this document you can often see more detail simply by zooming into the page.  Zoom options are usually available under an application menu such as View, or on most computers simply by holding down the Ctrl key and then using the mouse scroll wheel to zoom in and out as desired.

Most of the source document images have been cropped to enlarge the relevant portion as much as possible.  However the full underlying image is still available, so if you have access to the Microsoft Word version of this document and wish to see the rest of the image for some reason, you can uncrop an image by right clicking on the image, selecting the option Crop, and then dragging the crop handles on the middle of each side of the image outwards.  You can then copy or save the image to your desktop and import it into other documents at full original size if you wish. 

[bookmark: _Toc87280085][bookmark: _Toc111889338]Creating Your Own Document

If you wish to create your own document with some of the information from this document, there is a better approach than copying information from this document into a new document.  Instead, make a copy of this document file on your computer, then change the file name to whatever you wish, then open that copy and delete any information you don’t want, and then add new information as desired.  Modifying a copy of this document works better since it already has many of the styles set, so for example the headings show properly, the section headers and footers are continuous through the document, and the table of contents is formatted nicely, which can take a lot of work to set up in a brand new document.  Also, this document is already set to not compress embedded images, so images can be zoomed in to see additional detail.

If you wish to add new landscape pages, such as used for many of the census documents in this document, proceed as described below.  One you know how to do this, you can do it in seconds.

First create a new section by entering a section break, some blank lines, another section break, and then go back and set the middle part between the section breaks to be in landscape mode:

· Make sure the paragraph indicator is turned on, from Home > Paragraph > “¶”   
· Layout > Page Setup > Breaks > Next Page
· Press return several times to create some blank lines.
· Layout > Page Setup > Breaks > Next Page
· Arrow up before the second section break to the previous page with the blank lines.
· Layout > Page Setup > Orientation > Landscape

Then make sure the headers and footers will carry over from the previous sections.  If you are just adding a new section to a copy you made of this document, as recommended, then the following should already be set properly.  But you might want to check the first time to make sure.

· Double-click in the header of the new section you just made to put your mouse in the header, and make sure the following button is selected:
Header and Footer > Navigation > Link to Previous
· Double-click in the footer and make sure the same button is selected:
Header and Footer > Navigation > Link to Previous
· Double check both the header and footer after the new section by repeating the above steps in the document after the new section you just added.

If you are modifying a copy of this document, the following should not be an issue.  However, if you ever find the page number is restarting in some section, perhaps in a new landscape section you just added or the one after it, you can fix it by double-clicking to put your mouse in that footer, and select:

· Header and Footer > Header and Footer > Page Number > Format Page Numbers
· Then make sure the checkbox is selected “Continue from previous section”

Finally, make sure the total page numbers are correct.  When a Word document has multiple portrait and landscape sections, there is no simple way to make sure the total page numbers is correct, the number Y at the end of “Page X/Y” in the footer.  This must be done with a bookmark that tells the page numbering how many total pages the document has.  This bookmark and the page numbering defaults are already set up in this document.  All you have to do is make sure you don’t delete the line which has the bookmark, which looks like this “I”.  That is, don’t delete the last line in this section, the line clearly labelled “[END OF DOCUMENT - DO NOT DELETE THIS PAGE NUMBER BOOKMARK]”.

If you cannot see the “I” bookmark icon on that line, make sure you have selected File > Options > Advanced > Show Document Content > Show bookmarks.

Finally, always remember to right-click on the Table of Contents and the List of Images at the beginning of the document and select Update after any document changes to make sure they are complete and the page numbering is correct.

[bookmark: _Toc87280086][bookmark: _Toc111889339]Adding New People

You can research the genealogy websites and add people and information to a copy of this document if you wish.  Be prepared to take time to learn the sites, and then research the people you are interested in and collect the information.  If you make updates to the information on FamilySearch.org or Wikitree.com, note that you have a special responsibility to make extra sure it is accurate, since those sites are shared with the world.

First create accounts on the sites you are interested in, FamilySearch.org and/or Wikitree.com.  If you wish access to the significant number of sources available on Ancestry.com, you can create a paid account there as well.  You can start with one month on Ancestry.com, and then if desired upgrade to a six month or one year membership.  Remember that you retain access to your family tree on Ancestry.com if you stop paying for an account, however you will no longer have access to the sources, so if you wish to keep the sources you should download them.

Spend some time exploring and getting used to using each site.  Know how to show the tree view on each site.  It can be helpful to use multiple browser tabs so you can keep one page open and research other pages in other tabs.  Remember, you can open website pages in a separate tab in your browser by right-clicking on a link and selecting “Open link in new tab”, or on some computers if your mouse supports it simply by clicking the link with your scroll wheel.

On any of these sites, once you have entered yourself, your parents, and your grandparents, the sites might start suggesting others farther back, and then connect to the rest of the tree that is available in their database.  Ancestry.com will sometimes show you a “Potential” indicator.  On Ancestry.com, once you have a person entered, check out the “hints” tab.  Especially check out hints to other Ancestry profiles, then check the box to select all the other profiles, review them, and add any people that will extend your tree, such as parents of the person you are working on.  You will then get your own copy of these people added to your tree, since Ancestry.com does not share profiles with others.  When reviewing other people from other Ancestry.com profiles through a hint, note that any information that is new to your tree, such as more complete dates or places, will be shown as new on the left of the review page on the other person profiles.  You can select or unselect the checkboxes for these individual elements of information to add or choose not to add this information as you wish.

On FamilySearch and Wikitree, when you enter a new person, such as a great grandparent, if you have enough information entered, such as name and birth and death dates, the site will suggest existing people that might be a match.  On FamilySearch.org you can also enter the person’s parents or the name of their spouse to help the site see if the person is already in the database.  If the site suggests anyone that might be a match for the new person you are considering adding, always check out these other people, with right-click and open in new tab to investigate them further.  Whenever appropriate make sure you select an existing person if they match, since on FamilySearch and Wikitree everyone works on the same and hopefully accurate tree, and you don’t want to create duplicates of existing person profiles.  All the work you do on FamilySearch and Wikitree is shared with the world, so put in extra effort to only enter accurate information and make any changes to existing information you find very carefully.

On FamilySearch and Wikitree, if you do create a duplicate person by mistake, you can then merge them into the right profile.  If you discover duplicates made by someone else, you can merge them into one profile.  Merging profiles makes a lot of changes, so much be done especially carefully.  If you do any merging of profiles, make sure you understand the function very well, review all the information on both profiles to make sure the merge is absolutely the right thing to do, and then proceed carefully.

On all three sites, make sure any dates and locations you enter are “standardized”.  That is, when you enter a date or location, the site will suggest a standard format.  Make sure you click on that standardized format to select it, so the site can recognize and then use the date or location properly.

FamilySearch and Ancestry.com have the most complete set of sources for people farther back.  Review the “Sources” on FamilySearch and “Hints” on Ancestry.  Again, use the multiple browser tab trick - open these sources on other browser tabs so you don’t lose your current page, with right-click and open in new tab, or click the link with the mouse scroll wheel.  If the source is applicable, you can download it if desired, on FamilySearch simply by clicking the download button, and on Ancestry by clicking the little hammer and screwdriver icon and then selecting download.  You can then open the image file with your favorite image application, perhaps just by dragging it on top of a browser window since browsers will open images, then copy the image (perhaps by right-clicking and selecting Copy), and then paste it into your Word document.  You can then right-click the image and select “Crop” to crop it.  If you wish to resize the image, you sometimes have to hold down the Shift key before you drag a corner or edge, to make sure the image says the same proportion as you resize it. 

[bookmark: _Toc87280087][bookmark: _Toc111889340]Intra-Document Links

There are many links between sections of this document, for example between sections for parents and children.  There are also links from census references for one person to the subsection of the head of household where the census document can be found, to avoid duplicating information.

These intra-document links can be created easily, by selecting the text you wish to link, and then either Ctrl-k or Insert > Links > Link.

Then from the window that pops up, select “Place in this document” on the left, scroll to the section you wish to link to on the right, and select that section heading.

Once you have a link, you can copy it and paste it elsewhere, and the link will copy too.

Once you create a link to a section heading, you can change the text of the heading, or change the level by for example changing it from Heading 2 to Heading 3.  

However, while you can copy and paste links if you have multiple places you want to put a link, you should not copy a section heading itself and paste it elsewhere, since now Word does not know which heading any already created links should point at.  Similarly, never click in the middle of a section heading and press Return to split a heading into two headings, since this confuses Microsoft Word, and any intra-document links you have already created to that heading might no longer work.  (Neither of these problems should commonly occur, because most people have no need to copy or split headings, however just be aware of the problems that can occur if you do.)

[bookmark: _Toc87280088][bookmark: _Toc111889341]Ancestor Fan Charts

The six generation fan charts in the final Ancestor subsections for each person are from FamilySearch.org, and take a couple steps to be inserted in a Microsoft Word document with high resolution so the chart can be zoomed into for better readability.  The following steps seem detailed, but once you have done it a couple times it becomes easy, and is the only way I know of to get these fan charts into Word in high resolution zoomable format.

First, install the very useful free open source office suite http://LibreOffice.org.

Then the simplest way to create the fan chart is as follows: from your FamilySearch.org account, from the “Details” page of a person you wish to generate a fan chart, click “Fan Chart” from the print list on the bottom right of the page.  Or click “View tree” from the top right, then select “Fan Chart” from the options on the top left, then select “Print” from the options on the top right.  This will create a PDF file containing the fan chart.

Then open the PDF file of the fan chart with LibreOffice.  This can be done in one of two ways.  (1) Either open any LibreOffice application, such as LibreOffice Writer or Draw, select File > Open, and then find the fan chart PDF file you just created and open it.  (2) Or simply drag the fan chart PDF file onto the top border bar of any open LibreOffice application.

This will open the PDF with the LibreOffice Draw application.  Then:

· Select the fan chart with Ctrl-a 
· Export it in the highest resolution Encapsulated Postscript format, by selecting File > Export…
· Choose “EPS - Encapsulated Postscript” from “Save as type”
· Check the “Selection” box to export just the selected fan chart.
· Save the file.

You have now created a very high resolution file containing that fan chart.  Now, to get it into Word, first open the EPS file you just created with LibreOffice Draw.  On some systems, simply double-clicking the file will open it with LibreOffice Draw by default.  However, if some other application opens, then start the LibreOffice Draw application, and find and open the EPS file directly with File > Open.

Once the EPS file is open in LibreOffice Draw, select the fan chart with Ctrl-a, then copy it with Ctrl-c.  

Then in Microsoft Word, click your cursor where you wish the fan chart to go.  Paste it as “special”, either with the shortcut “Alt-e, s” (that is, hold down the Alt key, press “e”, then press “s”), or from the Word ribbon with “Home > Clipboard > Paste > Paste Special”.  Then choose the format “Picture (Enhanced Metafile)”.  

You now have the fan chart pasted in your document in the highest possible resolution.  If you have pasted it on a landscape page, you can drag the bottom right corner outwards to enlarge the image to create the largest possible image that will fit on that page.  And then if someone zooms into the fan chart, in the Word document or a PDF document, they will be able to more easily read the names printed in the smallest type in the outer edge of the fan chart.

[bookmark: _Toc87280089][bookmark: _Toc111889342]Printing This Document (PDF or Paper)

(Remember to always right-click on the Table of Contents and the List of Images at the beginning of the document and select Update after any document changes, to make sure they are complete and the page numbering is correct, before printing).

The best way to create a PDF is by selecting File > Save as, and then setting “Save as type” to PDF.  This is the only way to obtain a PDF with all the intra-document links working, the links from the table of contents and between sections.  For PDF files to be browsed on a computer, this is the best method.

You can also print this document to paper.  If you wish to get it bound, “coil” binding is better than “comb” binding, because it lasts longer and is easier to use, especially for larger documents.  You can also create a PDF for sending to a print shop with slightly higher image resolution by printing it as normal, but instead of selecting a physical printer, select a “PDF Printer” from the printer menu, for example “Microsoft Print To PDF” installed by default on most computers.  The images will have slightly higher resolution than saving the document as PDF, but the intra-document links won’t work.

If you ever wish to, you can also print only some sections of the document.  This requires a few more steps, because the document has so many different portrait and landscape sections.  First, make sure the paragraph indicator is turned on, from Home > Paragraph > “¶”   

Next, right-click on the bottom border of the Word application.  From the “Customize Status Bar” window that pops up, make sure “Section” is checked, so the current section number is displayed in the “status bar” on the window border bottom left.  In the example below, the section is shown as “260”, because that is how many different sections are in the document at the time I am writing this.

[image: ]

Then, figure out where you want your print to start and end.

First, make sure you can see the section separator markings, by making sure the paragraph indicator is turned on from Home > Paragraph > “¶”   

Section separators will look like this:

[image: ]

Place your cursor in the section where you want the print to start.  Wait a few seconds for the section number to update on the bottom left of the status bar.  Write down that section number. 

Then put your cursor in the section where you want the print to end.  Repeat the above to note that section number.  

Then open the print menu on Word, for example with <ctrl>-<p> or File > Print, and in the Pages field enter the first and last section you wish to print separated with a dash.  For example to print from section 42 to section 85 enter “s42-s85” without the quotes.  If you wish to print discontinuous sections, for example just section 21 and then from section 42 to 85, enter “s21,s42-s85” in the Pages field.  (If you don’t see the Pages field, look for the option Settings > Custom Print.)

Then print to a PDF printer first to create a PDF file, make sure you have what you want, and then print the PDF to paper.  Always print to a PDF file first, making sure you got the sections you intended, and then print the PDF to paper.  Just remember the intra-document links will not work in that PDF – selective section printing is only good for paper printing.

Enjoy!

[bookmark: LastPage][END OF DOCUMENT - DO NOT DELETE THIS PAGE NUMBER BOOKMARK ==> ]
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LOI ELECTORALE DU CANADA

LISTE PRELIMINAIRE DES ELECTEURS D'UN ARRONDISSEMENT RURAL

District électoral de Restigouche Arrondissement rural no.8 - St-Martin

Comprenant la partie de la paroisse de St.-Quentin bornée a u sud par la ligne nord des lots no. 15; rangs 13 & 18; a
l'ouest par la ligne de division entre les rangs 12 et 13 s'e tendant au nord jusqu'au ruisseau Five Fingers et bornée
de la par le dit ruisseau Five Fingers et de la par le prolo ngement de la ligne de division entre les rangs 4 et 5 de la

paroisse de Grimmer.
Bureau de votation - Parish Hall

D= D O CON -

Albert, Mme Donat, veuve, St. Martin
Albert, Leonide, cultivateur, St. Martin
April, Irene, cultivateur, St. Martin

April, Mme Irene, menagere, St, Martin
April, Yvon, camionneur, St. Maptin

April, Mme Yvon, menagere, St. Martin
Bellavance, Raoul, cultivateur, St. Martin
Bellavance, Mme Raoul, menagere, St. Martin
Bellavance, Claude, cultivateur, St. Martin
Bellavance, Mme Claude, menagere, St. Martin
Bellavance, Louis, camionneur, St. Martin
Bellavance, Mme Louis, menagere, St. Martin
Bellavance, Sylvio, cultivateur, St. Martin
Bellavance, Mme Sylvio, menagere, St. Martin
Bellavance, Mme Valmope, veuve, St. Martin
Bellavance, Gilbert, cultivateur, St. Martin
Bellavance, Mme Gilbert, menagere, St. Martin
Banville Irene, cultivateur, St. Martin
Banville, Mme Irene, menagere, St. Martin
Banville, Damase, cuitivateur, St. Martin
Banville, Mme Damase, menagere, St. Martin
Banville, Yvon, journalier, St. Martin
Banville, Albert, journaliey, St. Martin
Bujold, John, chauffeur, St. Martin

Bujold, Mme John, menagere, St. Martin
Bernier, Benoit, journalier, St. Martin
Bernier, Mme Benoit, menagere, St. Martin
Bellavance, Normand, mes. de bols, St. Martin
Charron, Leonce, pentier, St. Martin
Charron, Mme Leonce, menagere, St. Martin
Charron, Mme Michel, veuve, St. Martin
Cote, Noel, marchand, St. Martin

Cote, Mme Noel, menagere, St. Martin
Caron, Eugene, cultivateur, St. Martin
Caron, Mme Eugene, menagere, St. Martin
Capon, Mme Jos., veuve, St. Martin
Castonguay, Lorenzo, cultivateur, St. Martin
Castonguay, Mme Lorenzo, men., St. Martin
Coulombe, Augustin, journelier, St. Martin
Coulombe, Mme Augustin, men., St. Martin
Coulombe, Adrien, rentier, St. Martin
Couturier, Jos., journalier, St. Martin
Coutupier, Mme Jos., menagere, St. Martin
Cyr, oul, cultivateur, St. Martin

Cyr, Mme Raoul, menagere, 8t. Martin
Cyr, Onil, cultivateur, St. Martin

Cyr, Mme Onil, menagere, St. Martin

Cyr, Robert, infirmier, St. Martin

Dionne, Yvon, journaliey, St. Martin

Dionne, Mme Yvon, menagere, St. Martin
Dionne, Romeo, journalier, St. Martin
Dionne, Mme Romeo, menagere, St. Martin
Dionne, Magloire, cultivateur, St. Martin
Dionne, Mme Magloire, menagere, 8St. Martin
Dube, Raymond, cultivateur, St. Martin
Dube, Mme Raymond, menagere, St. Martin
Dube, Tpeffle J., cultivateur, St. Martin
Dube, Mme Treffle, menagere, St. Martin
Dube, Mlle Anita, fille majeure, St. Martin
Dube, Fernand, cultivateur, St. Martin
Dube, Mme Fernand, menagere, St. Martin
Dube, Leonce, professeur, St. Martin

Dube, Marcel, camionneur, St. Martin

Dube, Mme Marcel, menagepe, St. Martin
Durette, Maurice, cultivateur, St. Martin
Durette, Mme Maurice, menagere, St. Martin
Durette, Roland, cultivateur, St. Martin
Durette, Mme Roland, menagere, St. Martin
Dionne, Lorenzo, journalier, St. Maptin
Dionne, Mme Lorenzo, menagere, St. Martin
Fortin, Alfred, cultivateur, St. Martin
Fortin, Mme Alfred, menagere, St. Martin
Joubert, Albert, cultivateur, St. Martin
Jeubeyt, Mme Albert, menagere, St. Albert
Lamarche, Simon, cultivateur, St. Martin
Lamarche, Mme Simon, menagere, St. Martin
Lepage, Joseph, rentier, St. Martin

Lepage, Mme Joseph, menagere, St. Martin
Lepage, Romeo, camionneur, St. Martin
Lepage, Mme Romeo, menagere, St. Martin
Lepage, Patricks, cultivateur, St. Martin
Lepage, Mme Patrick, menagere, St. Maptin
Martel, Alderic, cultivateur, St. Martin

Martel, Mme Alderic, menagere, St. Martin

Malenfant, Sylvio, journalier, St. Martin
Malenfant, Mme Sylvio, menagere, 8t. Martin
Morin, Gilbert, rentier, St. Martin
Morin, Mme Gilbept, menagere, St. Martin
Malenfant, Valmont, journalier, St. Martin
Ouellet, Edgar, journalier, St. Martin
Ouellet, Donat, journalier, St. Martin
Paquet, Wilfrid, rentier, St. Martin
Paquet, Mme Wilfrid, menagere, St. Martin
Paquet, Leo, marchand, St. Martin
Paquet, Mme Leo, menagere, St. Maptin
Perreault, Joseph, journalier, St. Martin
Perreault, Mme Joseph, menagere, St. Martin
Plourde, Mme Camille, veuve, St. Martin
Plourde, Aymard, cultivateur, St. Martin
Plourde Mme Aymard, menagere, St. Martin
Poitras, Rev. Felix, ppete, St. Martin
Poirier, Hughes, journalier St. Martin
Quimpere, Gerard, cheminot, St. Martin
Quimpere, Mme Gerard, menagere, St. Martin
Quimpere, Ronald, etudiant, St. Martin
Quimpere, Roland, cheminot, St. Martin
Quimpere, Mme Roland, menagere, St. Maptin
Quimpere, Berthelet, etudiant, St. Martin
Ouimpere, Geraldine, fille majeure, St. Martin
Richards, Patrick, cheminot, St. Martin
Richards, Mme Patrick, menagere, St. Martin
Roy, Gerard, cultivateur, St. Martin
Roy. Mme Gerapd, menagere, St. Martin
Roy. Sylvio, etudiant, St. Martin
St.-Onge, Emmanuel, cultivateur, St. Martin
St.-Onge, Mme Emmanuel, men., St. Martin
S8t.-Onge, Mme John, veuve, St. Martin
St.-Pierre, Belone, journalier, St. Martin
St.-Pierre, Barome, journalier, St. Martin
St.-Pierre, Cecile, fille majeure, St. Maptin
St.-Plerre, Dollard, cultivateur, St. Martin
St.-Plerre, Etienne, mecanicien, St. Martin
St.-Pierre, Mme Dollard, menagere, St. Martin
St.-Plerre, Mme Etienne, menagere, St. Martin
St. Piepre, Philippe, menuisier, St.
St.-Plerre, Leopold, cultivateur, St. Martin
St. Pierre, Mme Leopold, menagere, St. Martin
St.-Plerre, Paul, cultivateur, St. Martin
St.-Plerre, Mme Paul, menagere, St. Martin
St.-Plerre, Gerard, menuisiey, St. Martin
St.-Plerre, Mme Gerard, menagere, St. Martin
Soucy, Lawrence, cultivateur, St. Martin
Soucy, Mme Lawrence, menagere, St. Martin
Soucy, Raymond, etudiant, St. Martin
Sirois, Mme Yvette, menagere, St. Martin
St.-Plepre, Jean-Claude, boucher, St. Martin
Adelard, cultivateur, St. Martin
Mme Adelard, menagere, St. Martin
Arthur, journalier, St, Martin
Mme Arthur, menagere, St. Martin
Theriault, Mme leo, veuve, St. Maptin
Theriault, Roger, professeur, St. Martin
Theriault, Mme Roger, menagere, St. Martin
Theriault, Rina, fillle majeure, St. Martin
Thibeault, Paul, rentier, St. Martin
Thibeault, Mme Paul, menagere, St. Martin
Truchon, Anathalie, journaliey, St. Martin

Je certifie par les présentes que ce qui précéde est
la liste préliminaire imprimée des électeurs de l'arron-
dissement rural no. 8 du district électoral de Resti-
gouche, telle qu'clle a été dreasde par I'énumérateur rural
intéressé, pour servir a l'élection en cours.

Daté a Dalhousie, N.-B.,, ce 13e jour de mai, 1968.

J. LUDGER BERNARD,
Officier rapporteur,

Printed by The Graphic Ltd., vhose address is 15 Ritchie Strcet, Campbeliton, N. B.
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1851 Birth + 2 Sources + Edit
Age0 15 February 1851
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

1874 (@ “2Toe
Age22 13 January 1874

Témiscouata, Québec, Canada

Joseph Abel Lepage
1848-1888 » 96X1-HI6

Birth of Child
1874
Age 23 (] 26 December 1874

Saint-Epiphane, Riviere-du-Loup, Québec, Canada

Napoleon Lepage.
1874-1951 « L82K-66P

1676 @) Birthof child
Age 25 4June 1876
Saint-Epiphane, Riviére-du-Loup, Québec, Canada
Marie Clotilde Lepage
1876-1928 « L82K-FP1
1676 @) Birthof child
Age 26 3 janvier 1878

Saint-Hubert, Saint-Hubert-de-Riviere-du-Loup, Riviére-du-Loup, Québec, Canada

Jean Baptiste Lepage
1878-1931  L82K-528

170 @) Birthor child
Age 28 8 June 1879

Saint-Epiphane, Riviere-Du-Loop, Quebec, Canada

Pierre Lepage
1879-Deceased « L822-M46
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1881
Age 28

1882
Age 31

1882
Age 31

1886
Age 35

1886
Age 35

1888
Age 36

1888
Age 36

Birth of Chi
30 January 1881
Saint-Epiphane, Rivier-du-loop, Quebec, Canada

Joseph Louis Lepage
1881-Deceased » L822-CMM

Birth of Child
22 April 1882
Saint-Epiphane, Riviére-du-Loup, Québec, Canada

Joseph Abel Alcide Lepage
1882-Deceased » L822-CQQ

Birth of Chi
9 June 1882
Saint-Epiphane, Riviére-du-Loup, Québec, Canada

Marie Claire Angelique Lepage
1882-Deceased » L8GM-CL1

Birth of Child
24 June 1886
9 saint-Epiphane, Riviere-du-Loup, Quebec, Canada

Alice Lepage
1886-1964 « GOOM-WFQ

Birth of Chi
25 June 1886
Saint-Epiphane, Riviére-du-Loup, Québec, Canada

Marie Euphemie Lepage
1886-Deceased » L8GM-C2F

Birth of Child
1888
9 Lawrence, Essex, Massachusetts, United States

Mary Lepage
1898-1889 « LSGM-BXS

Death of Spouse
1888
9 Massachusetts, United States

Joseph Abel Lepage
1848-1888 » 96X1-HI6
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1889
Age 38

1892
Agedl

1928
Age 76

1928
Age77

1931
Age 80

1939
Age 88

Death of Child
16 March 1889
9 Lawrence, Essex, Massachusetts, United States

Mary Lepage
1898-1889 « LSGM-BXS

Death of Parent
3 March 1892

9 Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada

Basilice Saindon
1830-1892 » L82W-TGB

Death of Child
1928
Sainte-Rose-du-Dégelé, Dégelis, Témiscouata, Québec, Canada
Benjamin Dionne
1857-1928 » GMZLTFN

Death of Child
18 June 1928
9 Concord, Merrimack, New Hampshire, United States

Marie Clotilde Lepage
1876-1928 » L82KFP1

Death of Child
8 avril 1931
Québec, Québec, Canada

Jean Baptiste Lepage
1878-1931  L82K-528

Death « 0 Sources + Edit
March 1939
Nouveau-Brunswick, Canada
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1863
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1863
Age 0

1882

Age 18

1885
Age 22

1889
Age 26

1891
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1895
Age 32

1895
Age 32

(2]

Birth « 4 Sources * Edit
1863
9 Lisle-Verte, Témiscouata, Quebec, Canada

Christening + 1 Source * Edit
21 October 1863
9 Llsle-Verte, Témiscouata, Quebec, Canada

Marriage

17 oct 1882

Saint-Paul-de-la-Croix, Riviére-du-Loup, Québec,
Canada

Etienne Thibeault
1860-1929 » L13G-355

of Child
1885

Etienne Thibeault
1885-1913 « G7GWIZB

rth of Child
26 APR 1889
St-Clement, Riviere-du-Loup, Quebec, Canada

. Marie Alma Thibault
1889-1989 « MTBLGZB

of Child

1891

Chs Eug Thibauit
1891-Deceased » G7GW-XKC

Death + 1Source * Edit
12 February 1895
9 saint-Clément, Témiscouata, Quebec, Canada

Burial + 1 Source * Edit
14 February 1895
9 saint-Clément, Témiscouata, Quebec, Canada
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16 October 1848
Saint-Germain-de-Rimouski, Rimouski, Québec, Canada

Marriage

13 January 1874

Témiscouata, Québec, Canada
Euphémie Dionne
1851-1939 » LB2W-TZ3

Birth of Child
26 December 1874

Saint-Epiphane, Riviére-du-Loup, Québec, Canada

Napoleon Lepage.
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Birth of Child
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Saint-Epiphane, Riviére-du-Loup, Québec, Canada
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Birth of Child
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Jean Baptiste Lepage
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Birth of Child
8 June 1879
Saint-Epiphane, Riviere-Du-Loop, Quebec, Canada

Pierre Lepage
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Birth of Child
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Joseph Louis Lepage
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22 April 1882
Saint-Epiphane, Riviére-du-Loup, Québec, Canada
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Birth of Child
24 June 1886
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Cette formule, placée dans une enveloppe non cachetée, marquée ‘‘ Statistiques Vitales’’ et correctement adressée,
> jouira de la franchise postale, par ordre du Ministre des Postes.
FORMULE C.-2. :

PROVINCE DU NOUVEAU-BRUNSWICK
DEPARTEMENT DE L’HYGIENE

AVIS OFFICIEL DE MARIAGE

0. d’enregistrement..
¢ (Réservé au rez/i:trnire général)
7 ’

district d’hygiéne de... ..Circonscription du sous-registraire adjoint de

Nom complet..
Occupation...
Célibataire, veuf ou divorcé.
Age.
Résidence...
(Si elle est au Canada, province,
Lieu de naissance..
Nom de son per

Lieu de naissance de son pére..

Nom de fille de sa mar

Le marié sait-il lire ?........

/Nom complet.:.

Occupation...
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4 ‘..Réuidcnce..

Lieu de naissance..

Nom de son pére...

Lieu'de naiaﬁs‘e‘l"nce de son’pére....

Nom de fille de 'sa mere.,

La mariée sait-ellelire ?.
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Lieu du mariage....

Par licence ou par bans
du mari.,

Signature

de la femme....

Nom..

Nom..

Adresse....

noms de famille et de baptéme, au complgt,_ de toutes les parties.

de ’omission.

Je certifie que les détails qui préc2dent sont exacts; au

Pasteur ou prétre célébrant.

NOTA.—Cette formule ne doit pas étre lacérée.

“Adresse.
Religion.

No. d’enregistrement...
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1848 Birth « 2 Sources + Edit
Age 0 23 Oct 1848
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

186 @ “oTise

Age 17 23 July 1866
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada
Francois Alexis April
1845-1915 « LKSC-7VP.
Birth of Child
1866
Age 17 (2] 15 September 1866

9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Ludger Louis April
1866-1944 « GOMM-LSH

rth of Child
1868

Age 19 (2] 1868

9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Emil April
1868-Deceased « GOMMTW3

1570 @ rth of Child
Age 21 24 June 1870

9 Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada

Waldray April
1870-1955 « GOMM-HRT

Residence + Edit
1871
Age 22 (] 1871
9 Témiscouata, Quebec, Canada
Birth of Child
1872
Age 23 (2] 1872
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada
Fridoline April

1872-Deceased « GOMM-16]
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1873
Age 24

1875
Age 26

1877
Age 28

1879
Age 30

1880
Age 31

1881
Age 32

1881
Age 32

Birth of Child
1873
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada
Pierre April
1873-Deceased » GOMM-1XM

Birth of Child

-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Ludgarde April
1875-Deceased « GOMM-24C

Birth of Child
1877
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Jean-Baptiste April
1877-Deceased » G3R6-76N

Birth of Child
1879
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Marie Anne April
1879-Deceased « GOMM-VQG

Death of Parent
17 Jul 1880
Nashua, Hilsborough, New Hampshire, USA

Jean-Baptiste Pinet
1811-1880 « KHCLYYS.

Residence « Edit
1881
9 Témiscouata, Quebec, Canada

Birth of Child
11 March 1881
9 Saint-Antonin, Riviére-du-Loup, Quebec, Canada

Joseph Gregoire William April
1881-Deceased » GOMM-NIN
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1883
Age3d

1886
Age 37

1886
Age 37

O—o—O-

Birth of Child
20 January 1883
9 Saint-Antonin, Riviére-du-Loup, Quebec, Canada

Francois Xavier April
1893-1963 » GOMQ-NY2

Death + 0 Sources » Edit
7 Aug 1886

9 Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada

Burial + 0 Sources » Edit
9 Aug 1886

9 Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada
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Birth + 1 Source * Edit
26 APR 1889
St-Clement, Riviere-du-Loup, Quebec, Canada

Death of Parent
12 February 1895
9 saint-Clément, Témiscouata, Quebec, Canada

Elise Lemieux
1863-1895 « G7WD-22Z

Marriage
13 JUL 1908
St-Clement, Riviere-du-Loup, Quebec, Canada

Joseph Napoléon Charron
1886-1977 « K8SD-PPP.

Birth of Child
28 NOV 1909
St-Clement, Riviere-du-Loup, Quebec, Canada

. Adrienne Charron
1909-1967 « MTBL-GZ3

Birth of Child
7 December 1910
9 New Brunswick, Canada

Gerard J Charron
1910-1986 » GCSL-2GF

Birth of Child
22 June 1912
9 Salem, Essex, Massachusetts, United States

Iréne Charron
1912-1989 « G8BF-4S1

Death of Parent
3 February 1929
9 Salem, Essex, Massachusetts, United States

Etienne Thibeault
1860-1929 » L13G-355
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Death of Child
17 AUG 1967
St-Martin,, Restigouche,New Brunswick

. Adrienne Charron
1909-1967 « MTBL-GZ3

Death of Spouse
Abt 1977

9 Saint-Martin-de-Restigouche, Saint-Quentin, Restigouche, New Brunswick,
Canada

Joseph Napoléon Charron
1886-1977 + K8SD-PPP. Saint-Martin-de-Restigouche, Saint-Qt
Death of Child

28 December 1986

9 Hartford, Connecticut, United States.

Gerard ] Charron
1910-1986 » GCSL-2GF

Death of Child
11 August 1989
9 Edmundston, Madawaska, New Brunswick, Canada

Iréne Charron
1912-1989 « G8BF-4S1

Death « 0 Sources + Edit
26 November 1989

9 Saint-Martin-de-Restigouche, Saint-Quentin, Restigouche, New Brunswick,
Canada
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Birth + 5 sources + Edit
15 July 1845
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Marriage
23 July 1866
9 saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada
Marie Victoire Pinet
18481886 + KZPV-5LQ

Birth of Child
15 September 1866
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Ludaer Louis April
1866-1944 + GIMM-LSH

Birth of Child
1868
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Emil April
1868-Deceased » GIMM-TW3

Birth of Child

24 June 1870

@ Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada

Waldray April
1870-1955 + GIMM-HRT

Birth of Child
1872
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Fridoline April
1872-Deceased + GSMM-16]

Birth of Child
1873
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

pierre April
1873-Deceased » GSMM-1XM

Birth of Child
1875
9 Saint-Georges-de-Cacouna, Riviére-du-Loup, Quebec, Canada

Ludaarde April
1875-Deceased » GSMM-24C
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rth of Child
1877

@ saint-Georges- de-Cacouna, Riviére-du-Loup, Quebec, Canada
Jean-Baptiste April

1877-Deceased » GIR6-76N

Birth of Chil
1879
@ saint-Georges- de-Cacouna, Riviére-du-Loup, Quebec, Canada
Marie Anne April
1873 Deceased + GIMM-VQG

Residence » Edit
1881
@ Témiscouata, Quebec, Canada

h of Cl
11 March 1881

9 saint-Antonin, Riviére-du-Loup, Quebec, Canada
Joseph Gregoire Wiliam April

1881-Deceased » GIMM-NIN

Desiré April
1883-Deceased » GIMQ-KM2

h of Cl
20 January 1883

9 saint-Antonin, Riviére-du-Loup, Quebec, Canada
Francois Xavier April

1883-1963 + GINQ-NY2

1885-Deceased » GIMQ-S6F

Mary April
1885-Deceased + GIMQ-CBB.
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Age 53

1915
Aage 69

Death of Spouse
7 Aug 1886
@ Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada
Marie Victoire Pinet
18481886 + KZPV-5LQ

4 August 1891
@ Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada

Obeline Tremblay
1862-1940 + GM1Y-WY2

rth of Child

3 June 1892

9 Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup,
Canada

Rose April
18921939 + GM1Y-48K

Death of Parent
1893

@ saint-Antonin, Riviére-du-Loup, Quebec, Canada

Georae April
1805-1893 » LDQZ-LKD.

5 December 1896
9 Saint-Hubert, Saint-Hubert-de- Rvisre-du-Loup, Rivisre-du-Loup, Quebec,
Cana

Marie Sibiane Barbe April
1896-Deceased » GSMM-HPL

Anna April
1899-Deceased » GIMQ-26G

Death * 0 Sources * Edit

3 April 1915

@ Saint-Hubert, Saint-Hubert-de-Riviére-du-Loup, Riviére-du-Loup, Quebec,
Canada
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Canada

1962

[+ Birth of Child
Age 27

25 Mar 1962
9 Fredericton, York, New Brunswick, Canada

Marie Rachel Christine Daigle
1962-Living » GEDS-VMS.

1964 @ Birth of Child
Age 29 13 June 1964

9 Moncton City, Westmorland, New Brunswick, Canada
Joseph Alain Francois Daigle
1964-Living » GD28-VN5

1966 0 Birth of Child
Age 31 9 March 1966
9 Moncton City, Westmorland, New Brunswick, Canada
‘Marie Nathalie Céline Daigle
1966-Living » GD98-XLB
Birth of Child
259 @ 3 December 1969
9 Moncton City, Westmorland, New Brunswick, Canada
Martin Jacques Daigle
1969-Living » GD98-4K9
1985 @ Death of Parent
Age 50 26 June 1985

9 Edmundston, Madawaska, New Brunswick, Canada
Aimé Désiré April
1909-1985 + GBBF-825

1989 @ Death of Parent
Age 54 11 August 1989

9 Edmundston, Madawaska, New Brunswick, Canada

Iréne Charron
1912-1989 « G8BF-4S1
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Birth « 4 Sources + Edit
20 décembre 1854

Saint-Eloi, Les Basques, Québec, Canada

Christening * o Sources * Edit
20 décembre 1854
‘Saint Eloi,Riviere-Du-Loup,Quebec

Residence * cdit
1861
St-Eloi, Témiscouata, Quebec, Canada

Marriage
9 February 1880
St Clement, Riviere Du Loup, Quebec, Canada

Auguste Charron
1855-1928 » K23C-15Q

Birth of Child
19 novembre 1880
Saint-Clément, Les Basques, Québec, Canada

Joseph Armand Charron
1880-1976 + K23C-12D

rth of Child
23 janvier 1882
St-Clement, Riviere-du-Loup, Quebec, Canada

Marie Emma Emilia Charron
1882 Deceased » MTEL-GDC

Birth of Child
5 aoat 1883
St-Clement, Riviere-du-Loup, Quebec, Canada

Marie Louise Charron
1883 Deceased » MTEL-GDR

rth of Child
26 FEB 1885
St-Clement, Riviere-du-Loup, Quebec, Canada

Marie Emma Charron
1885 Deceased » MTL-GSS
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26 octobre 1886
St-Clement, Riviere-du-Loup, Quebec, Canada

Joseph Napoleon dit Leonce Charron
18861977 + KBSD-PPP

St-Clement, Riviere-du-Loup, Quebec, Canada

Charles Omer Ludger Charron
1888-Deceased » MTEL-GXL
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9 Saint-Clément, Témiscouata, Quebec, Canada

Elie Théodore Aubut
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St-Clement, Riviere-du-Loup, Quebec, Canada
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h of CI
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A LA DOUCE MEMOIRE DE

Claive Anhut

(Epouse d'Augnste Charron)

Decedee a St-Clement, P.Q., le 27 ayril, 1921,
a l'age de 66 ans et 2 mois.

Maintenant que Ja mort o ferme mes paupe
res. aue le dernier chiaut du pretre du Seineur
sest fait entendre, que la tetre a cousert mon
corps. vous tous uni nraver aimee, priez pour
moi.

Toutceque je vous demande, parents et amis.
lest de vous souveni de moi devant Pautel du
Setgnear.

Adien, chera parents. consolez vous dans Pes-
Derance de nons rennir au ciel.

Consolez-vous avec moi, sous tous qui wretes
si chers; j'abandonne une vallee de larmes
pour le roaume des cienx

Une communion, an De Profundis. s, v. o,
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